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ProgramaPrograma parapara o o MMóódulodulo
� Formatações avançadas da folha de cálculo
Protecção de dados
Estilos de formatação
Modelos

� Fórmulas e Funções
Fórmulas e funções avançadas (IF; Vlookup; Hlookup, etc...)
Definir e utilizar nomes de células
Auditoria de fórmulas

� Séries de dados
Preenchimento automático de séries

� Gestão de dados
Gerir dados
Filtros automáticos e avançados
Ordenação de dados
As tabelas dinâmicas
Os níveis de dados
A utilização de subtotais
A consolidação de dados
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ProgramaPrograma parapara o o MMóódulodulo
� As técnicas de simulação
Cenários
Atingir objectivo
O Solver

� A criação de gráficos
Formatação avançada de gráficos
Formatação de gráficos tridimensionais

� Criar e utilizar macros

� Os Formulários

� Ferramentas de Revisão

� As ligações do Excel com outras aplicações
Importar texto do Word
Importar informação de uma base de dados

� A integração do Excel com a Internet
A transformação de documentos Excel em formato HTML 



RevisãoRevisão de de conceitosconceitos
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FunFunççõesões

= SUM(2;3;4;5)

Nome da função Argumentos da função

Caracter separador

Sintaxe

Nome_da_função (argumento; argumento2;…)

Exemplo
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AlgumasAlgumas FunFunççõesões

Average Média
Min Minimo
Max Máximo
Count Contar
Countif Contar se
Sum Somar
Sumif Somar se
Power Exponênciação
Today Hoje
Date Data
Now Agora

Nome Resultado
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DemonstraDemonstraççãoão da da 
utilizautilizaççãoão de de funfunççõesões
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CriarCriar ffóórmulasrmulas complexascomplexas usandousando
o o Function WizardFunction Wizard

Wizard- Assistente para construção de fórmulas.

Chamada do 
Function Wizard
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UtilizaUtilizaççãoão do do Function WizardFunction Wizard

Sintaxe da função seleccionada

Categorias
de funções

Funções
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CalculoCalculo da da mméédiadia usandousando o o WizardWizard
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DemonstraDemonstraççãoão da da 
utilizautilizaççãoão do do Function Function 

WizardWizard
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EstilosEstilos
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Novo EstiloNovo Estilo

1. Seleccionar a célula com o 
estilo criado

2. Format -> Style 

3. Escrever um nome para o 
estilo

4. Clicar em Add

5. Efectuar as modificações
necessárias

6. OK
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Juntar Estilo de outra FolhaJuntar Estilo de outra Folha

1. Format -> Style 

2. Clicar em Merge

3. OK
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Botão de EstiloBotão de Estilo
� Na barra de formatação, clicar com o botão direito e escolher a 

opção “customize”

� Arrastar de seguida o botão para a barra de formatação.
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EstilosEstilos

� Quero usar estilos que criei em outras folhas. 
Como posso usá-los?
• Abrir um livro onde pretendemos juntar os estilos

• Juntar os estilos (botão “merge”)

• Gravar como Template (*.xlt)
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FormataFormataçção de cão de céélulas mediante lulas mediante 
condicondiççõesões

� Objectivo: Formatar células mediante a 
verificação de condições (Format � Conditional 
Formatting).

� Exemplo: assinalar todas as notas inferiores ou 
iguais a 12 valores



18

Resultado ....Resultado ....
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GrGrááficosficos

1. Seleccionar a 
àrea que contém
a informação
para o gráfico.

2. Chamar o
“chart wizard”

3. Seguir os passos
apresentados

Chart wizard
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A A utilizautilizaççãoão do do ““Chart WizardChart Wizard””

Seleccionar o tipo de gráfico
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Verificar / Identificar a gama de valores

A A utilizautilizaççãoão do do ““Chart WizardChart Wizard””
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A A utilizautilizaççãoão do do ““Chart WizardChart Wizard””

Titulo do gráfico

Etiqueta para o 
eixo do X

Etiqueta para o 
eixo do Y
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As opções para a colocação da legenda

A A utilizautilizaççãoão do do ““Chart WizardChart Wizard””
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A A utilizautilizaççãoão do do ““Chart WizardChart Wizard””

As etiquetas no gráfico (data labels)
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A A utilizautilizaççãoão do do ““Chart WizardChart Wizard””

A localização do gráfico
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O O grgrááficofico comocomo objectoobjecto
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FormataFormataççãoão de de grgrááficosficos

Depois do gráfico elaborado poder-se-á alterar a sua
aparência, formatando os vários elementos que o
constituem.

Há várias maneiras de aplicar alterações, no entanto, a mais
fácil é um duplo clique  no elemento em causa.
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ModificaModificaçções ao grões ao grááficofico

� Mudar tipo de gráfico

� Mudar séries de dados
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ModificaModificaçções ao grões ao grááficofico

� Adicionar dados

� Ou com copiar e colar especial 
em cima do gráfico
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ModificaModificaçções ao grões ao grááficofico

� Mostrar a segunda série
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ModificaModificaçções ao grões ao grááficofico

� Mostrar valores em ordem inversa
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ModificaModificaçções ao grões ao grááficofico

� Adicionar uma TrendLine
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ModificaModificaçções ao grões ao grááficofico

� Adicionar uma imagem às séries
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GrGrááficos 3Dficos 3D
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Modificar GrModificar Grááficos 3Dficos 3D

� Modificar Visão
• Seleccionar as paredes
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Modificar GrModificar Grááficos 3Dficos 3D

� Mudar Séries de dados
• Format -> Selected Data Series
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DemonstraDemonstraççãoão da da 
criacriaçção/formataão/formataççãoão de de 

grgrááficosficos
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Trabalhar com dados em listasTrabalhar com dados em listas

� Ordenação de dados
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CritCritéério de ordenario de ordenaççãoão

1º critério de ordenação

2º critério de ordenação

3º critério de ordenação
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OrientaOrientaçção da Ordenaão da Ordenaççãoão

� O Excel permite alterar a 
orientação da ordenação, 
isto é, escolher entre 
ordenação por linha ou 
coluna

� Data�Sort...... (Options)
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SSééries de Preenchimentories de Preenchimento
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Criar SCriar Sééries de Preenchimentories de Preenchimento

� Seleccionar e arrastar com o botão direito do rato
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SSééries e Tendênciasries e Tendências

� Baseado no histórico
• Exemplo – Saber o crescimento das vendas nos próximos meses 
baseado nos últimos três
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Criar Listas / SCriar Listas / Séériesries

� Tools -> Options
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Definir nomes de cDefinir nomes de céélulas / intervaloslulas / intervalos

OU
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Utilizar nomes de cUtilizar nomes de céélulas / lulas / 
intervalosintervalos
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CriaCriaçção de ão de SubtotaisSubtotais
� Em Excel é possível criar, de forma automática, 
subtotais de valores em listas sem recorrer à
criação de formulas;

� Opção:  Data�Subtotals
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CriaCriaçção de ão de SubtotaisSubtotais

Indicadores
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Remover Remover SubtotaisSubtotais

Remover Subtotais
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Listas e FormulListas e Formuláários de Dadosrios de Dados

� Por definição, uma base de dados é uma colecção 
de informação organizada;

� Uma base de dados é constituída principalmente 
por tabelas, registos e Campos;

� Em Excel, uma lista presente numa folha pode 
servir como uma base de dados; 

� Entende-se por lista um conjunto de múltiplas 
linhas, com tipos de dados semelhantes;

� Em Excel as linhas servem de registos e as colunas 
de campos;
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TabelasTabelas

Registo

Nome do campo

As funcionalidades para tratar dados estão disponAs funcionalidades para tratar dados estão disponííveis no menu veis no menu ““DATADATA””

Campo
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CriaCriaçção de formulão de formulááriosrios

� Para criar um formulário é necessário:
• Seleccionar a informação que pretendemos tratar através de 
formulários;

• Escolher no menu “Data” a opção “Form”

� Utilização do formulário
• A utilização do formulário é possível através dos botões 
disponíveis na caixa de dialogo respectiva.
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AplicaAplicaçção de Formulão de Formulááriosrios

DataData-->>FormForm
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IntroduIntroduçção de dados no ão de dados no 
formulformulááriorio

Fazer um clique no 
botão “new” e preencher 

a informação para os campos

As alterações efectuadas 
reflectem-se na lista que 
originou o formulário
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NavegaNavegaçção num formulão num formulááriorio

Registo anterior
Registo Seguinte
(respectivamente)
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EliminaEliminaçção de registosão de registos

Seleccionar o registo a 
eliminar e fazer um 
clique no botão Delete
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Consultar dados no FormulConsultar dados no Formulááriorio

1- Fazer um clique no botão “Criteria”
2- Colocar o critério pretendido
3- Premir “Enter”

Na escolha do critério
podem utilizar-se os 
operadores lógicos
<; >; >=; <=; <>
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UtilizaUtilizaçção de Filtrosão de Filtros

� A utilização de filtros aplica-se quando 
pretendemos esconder temporariamente 
informação;

� Quando se aplicam filtros, o Excel esconde todos 
os valores que não respeitem o critério 
estabelecido;

� Podemos utilizar filtros mais ou menos elaborados;

� Existem filtros automáticos, contudo é possível 
elaborar os nossos próprios filtros;
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UtilizaUtilizaçção de Filtrosão de Filtros

Opção: Data - Filter
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Filtros automFiltros automááticosticos

Aparecem setas

Através das setas podemos escolher o critério a aplicar.
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CriaCriaçção de filtros personalizadosão de filtros personalizados

Criar o critério pretendido

Podemos criar filtros com 
dois critérios de comparação 

utilizando and/or
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UtilizaUtilizaçção de funão de funçções de procuraões de procura

� O Excel dispõe de 2 funções que permitem 
procurar valores relacionáveis;
• VLOOKUP (PROCV) – procura um valor na coluna mais à
esquerda, e retorna o valor da linha, presente na coluna que 
especificamos.

• HLOOKUP (PROCH) – procura um valor comparável com a linha

� Exemplo de aplicação
• Determinação da nota de 1 aluno em determinada disciplina
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VLOOKUP & HLOOKUPVLOOKUP & HLOOKUP

� Sintaxe das funções:
•VLOOKUP(Lookup value; Table array; Column index number)

•HLOOKUP(Lookup value; Table array; Row index number)

Onde:
• Lookup value – É o valor que a função procura na primeira 

coluna/linha superior da tabela;
• Table array – É o intervalo de células que contém a tabela com os 

valores;
• Column index number / Row index number – É a coluna/linha da 

Table array ónde constam os valores que estamos interessados. 
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Ver as fVer as fóórmulas nas crmulas nas céélulaslulas

Ver Formúlas

Pode-se também usar a combinação de teclas Ctrl + Shift + ´
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Exemplos VLOOKUPExemplos VLOOKUP

Neste caso, é necessário ordenar previamente
a tabela para não haver erros
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Exemplos HLOOKUPExemplos HLOOKUP

Com FALSE não é
necessário 
ordenar

previmente a tabela
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FunFunçções de Base de Dadosões de Base de Dados

� Dcount – Similar à função count

� Dcounta - Similar à função counta (não nulos)

� Dsum - Similar à função sum

� Daverage - Similar à função average

� Etc...
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Algumas funAlgumas funççõesões
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Tabelas DinâmicasTabelas Dinâmicas

� As tabelas dinâmicas permitem 
confrontar/analisar informação de acordo com as 
especificações colocadas;

� Os campos que serão confrontados são escolhidos 
durante o processo de criação da tabela;
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CriaCriaçção de tabelas dinâmicasão de tabelas dinâmicas

DATA - PIVOT TABLE
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Passo 2Passo 2
� Indicação do intervalo que contém a informação

Passo 3Passo 3
� Escolha do posicionamento da tabela pivot
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ConstruConstruçção da tabelaão da tabela

Apenas é necessário fazer drag-and-drop para os locais onde se 
pretende o campo
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Criar um gráfico

Estilos pré-definidos

Actualizar dados
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Fazer projecFazer projecçções sobre dadosões sobre dados

� Utilização da função PMT()
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Exemplo IExemplo I

NOTA: A taxa apresentada é uma taxa ANUAL. 
Como estamos a calcular o valor da prestação 
mensal, temos que a dividir por 12 (nº de meses 
num ano)
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Exemplo IExemplo I
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CriaCriaçção de cenão de cenááriosrios

� A utilização de cenários permite atribuir nomes a 
um conjunto de valores, que podem ser 
utilizados para efectuar uma série de operações 
numa folha;

� Passos para criar um cenário
1. Seleccionar a primeira célula a alterar com base no cenário;

2. Escrever um valor que se pretende incluir no cenário;

3. Seleccionar o intervalo de células que contém os valores que 
se pretendem alterar com base no cenário;
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CriaCriaçção de cenão de cenáários rios -- Passo 1Passo 1
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CriaCriaçção de cenão de cenáários (rios (contcont))

Invocar o sumário

Escolher o tipo 
de relatório
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ResultadoResultado
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UtilizaUtilizaçção do Solverão do Solver
� O “Solver” utiliza-se quando se pretende encontrar a melhor 
solução para um problema, considerando um conjunto de 
restrições específicas;

� Uma restrição é um limite imposto.

� Se o “Solver” não estiver visível:

• Tools�Add-ins�”Solver Add-in”

• Confirmar com “OK”
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Resolver o problema com o Resolver o problema com o 
““SolverSolver””

� Seleccionar: Tools�Solver

� Escolher a célula onde será colocado o resultado

� Definir as condições;

� Definir as restrições;

� Fazer um clique em “solver”
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Exemplo de utilizaExemplo de utilizaçção do Solverão do Solver

� Considere-se a situação de um agregado familiar 
onde:

• Vencimento 1000 Euros

� Despesas
• Desp. Familiares

• Desp. Alimentação

• Desp. Transporte

• Saldo
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CondiCondiççõesões

� Problema: Qual o máximo que é possível dispender
para a prestação da casa?

� Condições:
• O saldo mensal do agregado familiar deverá ser >= 100 euros

• A prestação da habitação deverá ser <= 40% * vencimento
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SoluSoluççãoão



87



88

UtilizaUtilizaçção de Auditoriasão de Auditorias

� As ferramentas de Auditing permitem fazer uma 
auditoria da folha Excel;

� Opção: Tools�Auditing
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UtilizaUtilizaçção da Funão da Funçção ão ““IfIf””

� A função “if” (Se) utiliza-se para testar conteúdos 
das células e determinar se as células cumprem 
com determinadas condições;

� É possível utilizar as funções OR (ou) e AND (e) em 
conjunção com a If;

� Sintaxe:
• If (teste lógico; Valor se verdadeiro; Valor se Falso)

� Exemplo:
• If (Media>9,5; Aprovado; Reprovado)
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UtilizaUtilizaçção do ão do ““IfIf””
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UtilizaUtilizaçção do ão do ““AndAnd””
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Trabalhar com MacrosTrabalhar com Macros

� A utilização de Macros permite automatizar um 
conjunto de acções;

� A forma de utilização é semelhante à do Word; 



94

Criar uma MacroCriar uma Macro

Nome da Macro

Terminar a gravação 
da Macro
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Seleccionar/Invocar uma MacroSeleccionar/Invocar uma Macro
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Adicionar uma Macro a um botão Adicionar uma Macro a um botão 
e coloce colocáá--la na barra de Tarefasla na barra de Tarefas

� É possível associar a Macro a um botão para mais 
facilmente a invocar;

� É também possível colocar o botão na barra de 
tarefas

� Opção: Menu  View�Customize
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Adicionar uma Macro a um botão Adicionar uma Macro a um botão 
e coloce colocáá--la na barra de Tarefasla na barra de Tarefas

� Passos:
1. Invocar a opção de Menu   View�Toolbars �Customize

2. Fazer um clique no separador “Commands”

3. Fazer um clique em “Macros” na lista “Categories”

4. Fazer um clique no botão “Custom Button”

5. Arrastar a imagem genérica para a barra de tarefas

6. Fazer um clique em “Modify Selection”

7. Seleccionar a Macro pretendida na lista “Assign Macro” e OK
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Adicionar uma Macro a um botão e Adicionar uma Macro a um botão e 
coloccolocáá--la na barra de Tarefasla na barra de Tarefas

1- Invocar a opção de 
Menu   View �

Toolbars

2 - Fazer um clique no 

separador “Commands”
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Adicionar uma Macro a um botão Adicionar uma Macro a um botão 
e coloce colocáá--la na barra de Tarefasla na barra de Tarefas

3 e 4 – Fazer um clique em 
“Macros” na lista “Categories”
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Adicionar uma Macro a um botão Adicionar uma Macro a um botão 
e coloce colocáá--la na barra de Tarefasla na barra de Tarefas

5 - Arrastar a 
imagem 
genérica

para a barra de 
tarefas
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Adicionar uma Macro a um botão Adicionar uma Macro a um botão 
e coloce colocáá--la na barra de Tarefasla na barra de Tarefas

7 - Seleccionar a 
Macro pretendida 
na lista “Macro 
Name”

6 - Fazer um clique em “Modify Selection” e “Assign Macro”
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GravarGravar documentosdocumentos parapara a a 
InternetInternet

Esta opção permite
duma forma rápida,
gravar documentos
em HTML, de forma
a tornar possível a sua
divulgação na Internet.
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Abrir ModelosAbrir Modelos
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Criar ModelosCriar Modelos
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FormulFormulááriosrios

� Definir a estrutura
1. Planear o formulário

2. Definir o esqueleto

3. Adicionar interactividade

4. Proteger o formulário

5. Distribuir como modelo ou documento
• Mail
• Rede

� Preencher e guardar informações de um 
formulário 
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FormulFormulááriosrios
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Adicionar Controles aos FormulAdicionar Controles aos Formulááriosrios
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Adicionar Controles aos FormulAdicionar Controles aos Formulááriosrios
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Adicionar Controles aos FormulAdicionar Controles aos Formulááriosrios
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Adicionar Controles aos FormulAdicionar Controles aos Formulááriosrios
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Adicionar Controles aos FormulAdicionar Controles aos Formulááriosrios

� Adicionar IFs
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Adicionar Controles aos FormulAdicionar Controles aos Formulááriosrios
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Adicionar Controles aos GrAdicionar Controles aos Grááficosficos
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Adicionar Controles aos GrAdicionar Controles aos Grááficosficos
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Adicionar Controles aos GrAdicionar Controles aos Grááficosficos
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Adicionar Controles aos GrAdicionar Controles aos Grááficosficos
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Adicionar Outros ControlesAdicionar Outros Controles
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Proteger folhas de cProteger folhas de cáálculo e Livroslculo e Livros

� A protecção efectua-se mediante a colocação de 
passwords. É possível:
• Definir uma password para evitar um acesso não autorizado;

• Definir uma password para evitar um alterações não 
autorizadas;

• Abrir um livro (workbook) só

para leitua.
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Protecção da Folha Protecção do livro

Protecção da partilha

Desprotecção da Folha

Proteger folhas de cProteger folhas de cáálculo e Livroslculo e Livros
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Trabalho CooperativoTrabalho Cooperativo

� Revisão
• Comentários

• Tracked Changes/Registo de Alterações
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ComentComentááriosrios

� View – Toolbars - Reviewing
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Inserir ComentInserir Comentááriorio

Novo 
Comentário
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ComentComentáários de Mrios de Múúltiplos Revisoresltiplos Revisores
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ComentComentáários de Mrios de Múúltiplos Revisoresltiplos Revisores
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Pesquisa de InformaPesquisa de Informaçção nos ão nos 
ComentComentááriosrios
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Imprimir InformaImprimir Informaçção de Comentão de Comentááriosrios
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Registo de AlteraRegisto de Alteraççõesões
Ligar 

Registo de 
Alterações
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Registo de AlteraRegisto de Alteraççõesões
Desligar 

Registo de 
Alterações
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Aceitar / Rejeitar AlteraAceitar / Rejeitar Alteraççõesões

� Tools -> Track Changes -> Accept or Reject 
Changes
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Envio para RevisãoEnvio para Revisão
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As ligaAs ligaçções do Excel com as ões do Excel com as 
restantes aplicarestantes aplicaçções do Office ões do Office 
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